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1 Introduction 

VeriFinger  12.3/MegaMatcher  12.3  Algorithm  Demo  application  demonstrates  the  advanced  capabilities  of  Neurotechnology
fingerprint  recognition  engine.  The  program is  a  Windows  7/8/10,  Linux  OS 3.10  kernel  (or  newer)  or  Mac  OS X  application
controlled via a pull-down menu system.

The application has three operation modes:

1. Fingerprint enrollment. Software processes the fingerprint image, extracts features and writes them to the database.

2. Fingerprint verification mode. This mode performs 1:1 fingerprints matching.

3. Fingerprint identification mode. This mode performs 1:N fingerprint matching. Using this mode fast or full fingerprints 
matching can be performed.

Operation can be selected by pressing "Enroll", "Identify" or "Verify" button and providing a fingerprint image. 

Neurotechnology fingerprint recognition algorithm demo shows how to considerably decrease the recognition time by stopping
the fingerprint matching process when positive matching result is found (successful identification). To turn off this feature go to
"Options" dialog (Tools»Options…) and select "Stop on first result".

In  the  application  the  database  entries  are  pre-sorted  using  certain  global  features.  Thereafter,  matching  is  performed  first
within small  part  of the database entries having most similar global features to those of the test fingerprint.  If  matching within
this  group  yields  no  positive  result,  then  the  next  group  with  most  similar  global  features  is  examined  and  so  on,  until  the
matching is successful  or the end of the database is reached (this behavior can be changed by modifying value of "Match at
most XXX% of database" in "Options" dialog). In most cases there is fairly good chance that correct match will be found already
in  the  first  group.  Consequently,  the  number  of  comparisons  required  to  achieve  positive  matching  becomes  drastically
decreased, and correspondingly, the effective matching speed increases. This feature can be used with fast identification mode
(in this case G is used).

1.1 System Requirements 
The exact system requirements highly depends on the use scenario, some approximate minimal requirements are listed below.

Hardware requirements:

• x86 (32-bit) or x86-64 (64-bit) compatible processors.

• AVX2 support is highly recommended. Processors that do not support AVX2 will still run the Neurotechnology 
algorithms, but in a mode, which will not provide the specified performance. Most modern processors support this 
instruction set, but please check if a particular processor model supports it.

• The CPU plugin supports inference on Intel® Xeon® with Intel® AVX2 and AVX512, Intel® Core™ Processors with 
Intel® AVX2, Intel Atom® Processors with Intel® SSE.

• 2 GB of free RAM is recommended for general usage scenarios. It is possible to reduce RAM usage for particular 
scenarios.

• (Optionally) A webcam or IP camera or any other camera (recommended frame size: 640 x 480 pixels) for face images 
capturing. Neurotechnology SDK includes support modules for a list of cameras. An IP camera should support RTSP and 
stream video in H.264 or M-JPEG. Cameras, which can operate in near-infrared spectrum, can be also used for image 
capture. Any other webcam or camera should provide DirectShow, Windows Media or Media Foundation interfaces for 
Windows platform, GStreamer interface for Linux and Mac platforms.

• (Optionally) Fingerprint scanner. Neurotechnology SDKs includes support modules for more than 150 models of fingerprint 
scanners under Microsoft Windows, Linux and Mac OS X platforms. See the list of supported fingerprint scanners.

• (Optionally) Iris scanner (recommended image size: 640 x 480 pixels) for iris image capture. Neurotechnology SDKs 
includes support modules for several iris cameras. See the list of supported iris scanners.
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• (Optionally) Microphone. Any microphone that is supported by the operating system can be used.

Microsoft Windows specific requirements:

• Microsoft Windows 7 / 8 / 10, 32-bit or 64-bit. Note that some fingerprint scanners are supported only on 32-bit OS or only 
from 32-bit applications.

• Microsoft .NET framework 4.5 or later (for .NET components usage)

• Microsoft Visual Studio 2012 or newer (for application development with C++ / C# / VB .NET)

• Sun Java 1.7 SDK or later (for application development with Java)

Linux specific requirements:

• Linux 3.10 or newer kernel (32-bit or 64-bit) is required. If a fingerprint scanner is required, note that some scanners have 
only 32-bit support modules and will work only from 32-bit applications.

• glibc 2.17 or newer

• GStreamer 1.10.x or newer with gst-plugin-base and gst-plugin-good is required for face capture using camera/webcam or 
rtsp video. GStreamer 1.4.x or newer is recommended.

• libgudev-1.0 219 or newer (for camera and/or microphone usage)

• alsa-lib 1.1.6 or newer (for voice capture)

• gcc 4.8 or newer (for application development)

• GNU Make 3.81 or newer (for application development)

• Sun Java 1.8 SDK or newer (for application development with Java)
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2 Application 

VeriFinger 12.3/MegaMatcher 12.3 Algorithm Demo is menu-driven software designed with intention to give the potential user a
possibility  to  test  our  fingerprint  image  processing  and  recognition  engine  in  action.  Using  Neurotechnology  fingerprint
recognition algorithm demo application mainly  involves running fingerprint  enrollment,  enrollment  with features generalization,
verification and identification procedures, described below.

2.1 Windows 
VeriFinger  12.3/MegaMatcher  12.3  Algorithm  Demo  application  in  Windows  OS  can  be  started  from
FingersAlgorithmDemo.exe.

2.1.1 Main Window 

The main Neurotechnology fingerprint  recognition algorithm demo window contains a menu bar and a toolbar  at  the top,  and
four child windows. During fingerprint enrollment, the top right window contains the original fingerprint image, while the top left
window  contains  the  same  image  after  the  image  filtering/processing/feature  extraction  is  shown  with  features  and  their
directions marked in red by circles and lines. During fingerprint matching, the top left contains the image to be matched, while
the top right window contains the image from the database it is being matched against.

In  the  bottom-left  window,  enrollment  and  recognition  information  (enrolled/recognized  file  name,  fingerprint  processing  and
matching  times,  number  of  samples  matched,  etc.)  is  displayed.  In  the  bottom  right  window,  individual  matching  scores
between different fingerprints (in identification mode) are displayed.

The VeriFinger 12.3/MegaMatcher 12.3 Algorithm Demo application's window: 
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(The right upper pane shows fingerprint image from database. The upper left pane shows extracted fingerprint features.)

2.1.2 Fingerprint Input 

Neurotechnology fingerprint  recognition algorithm demo allows reading fingerprints  from all  supported scanners.  Before using
scanner please install scanner driver provided in demo drivers directory.

Neurotechnology fingerprint recognition algorithm demo software also allows reading fingerprint images from image files (either
*.bmp,  *.wsq  or  *.tif).  There  is  a  collection  of  sample  fingerprint  images  (in  *.bmp  format)  available  for  download  from
Neurotechnology web site (http://www.neurotechnology.com/download.html).

Fingerprint enrollment

For  the fingerprint  enrollment  demonstration,  press "Enroll"  button on the toolbar.  Then,  open file(s)  or  scan a  fingerprint.  To
stop a long enrollment operation choose "File->Cancel".

Note: When working with a big number of image files file list can be created for later use.

Fingerprint Verification

Press "Verify" button on the toolbar and open two files or scan two images.

Fingerprint Identification

For  the  fingerprint  identification  demonstration,  press  "Identify"  button  on  the  toolbar.  Then  open  file(s)  or  scan  an  image  to
identify.

After the identification demo application will  output the record names of the most similar fingerprint together with the similarity
criterion (to see all matching result deselect "Stop on first result" in Options dialog (  see page 5)) and various characteristics
of the recognition process.
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To stop lengthy enrollment or identification operations choose "File->Cancel".

Note: When working with big number of image files the file list can be created for later use.

2.1.3 Options Dialog 

VeriFinger  12.3/MegaMatcher  12.3  Algorithm  Demo  allows  to  change  various  parameters  of  Neurotechnology  fingers
recognition algorithm. Algorithm parameters can be changed using Options window (Tools->Options...).

Enrollment

• Minimum minutia count - minimum required minutia count for fingerprint to be enrolled to database.

• Quality threshold - controls how strict rules are applied when determining the quality of a fingerprint for extraction.

• Template size - size of fingerprint image templates. Can be used Large or Small template. It is recommended to use large 
template size.

• Extracted ridge counts - type of extracted ridges count.

• Returned processed image - type of returned image.

• Fast extraction – if checked, feature extraction will be performed faster, but with accuracy loss.

2.1 Windows VeriFinger 12.3/MegaMatcher 12.3 Options Dialog
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Matching

• FAR - threshold that separates identical and different fingerprints. Matching threshold is linked to false acceptance rate 
(FAR, different fingerprints erroneously accepted as of the same) of matching algorithm. The higher is threshold, the lower 
is FAR and higher FRR (false rejection rate, same fingerprints erroneously accepted as different) and vice a versa.

• Maximal rotation - maximal fingerprint's rotation value.

• Matching speed - matching speed. Can be chosen Low, Medium or High speed. Default value is Low.

• Maximal results count – maximum number of matching results returned.

• First result only – if checked, only the first positive result will be returned during identification.

2.2 Linux 
VeriFinger  12.3/MegaMatcher  12.3  Algorithm Demo application  on  Linux  can  be  started  from FingersAlgorithmDemo  file.
There are separate distribution for 32 bits and 64 bits operating system. See Windows (  see page 3) part to find out how to
use this application.

2.3 Mac OS X 
VeriFinger  12.3/MegaMatcher  12.3  Algorithm  Demo  application  on  Mac  OS  can  be  started  from
FingersAlgorithmDemo.app file. See Windows (  see page 3) part to find out how to use this application.
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3 Proper Use of a Fingerprint Scanner 

General guidelines:

The finger should be put flat on the scanner, finger-pad down on the scanning surface.

Wait for the scanner to react to the finger and give it time to scan it. Do not remove the finger until the scanner gives a specific
signal - a beep, a LED flicker, etc.

Do not move your finger or palm while the scanning is in process.

Finger position: 

Do not  put  the  finger  on  the  scanner  finger-tip  down,  for  then the  surface  of  the  finger  will  not  be  large  enough for  a  proper
scanning to occur. For the same reason, do not put the finger on the scanner side-down. Make sure as much of the scanning
surface as possible is covered by your finger-pad.

Do not put the finger upside-down (or make sure that you are holding the scanner the right side down, for that matter). Note,
that  the  algorithm  allows  options  for  upside-down  fingerprint  scanning,  although  they  may  affect  the  FAR  (false  acceptance
rate) or FRR (false rejection rate).

Press the finger down lightly  and evenly throughout  the capturing process.  Use as much pressure needed to hold a piece of
paper between your fingers. Pressing too hard or too light may result in an overly dark or light image.

If you are scanning a palm or a number of finger, keep the fingers as close together as possible without them actually touching
each other (keep approx. 2-5 mm gaps between finger-pads).

General tips:

It is advisable to have the finger clean and neither wet nor too dry, as it all ruins scanning accuracy.

In case of an automatic fingerprint scanner please remember, that the sensor may not detect the finger when it  is placed too
softly or too slowly on the scanner.

If  the automatic scanner does not  react  to the finger (LED does not turn on,  the scanner does not  start  blinking,  no sound is
played, etc. - depending on the scanner model), remove the finger, wait five seconds and try again.

Make sure that the scanner itself is clean before scanning.

It is advisable to have a scan assistant, who would inform the users of how the scanner is properly used and ensure that they
follow these instructions and the scanning is successful.

The pictures below depict the correct way of using the fingerprint scanner and the most common mistakes.

The correct way of using the scanner. 
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The incorrect ways of using the scanner. 
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4 Support 

If  you  encounter  problems  while  installing  or  using  Neurotechnology  Iris  Recognition  Algorithm  Demo  application,  please
contact Neurotechnology (support@neurotechnology.com) or your local distributor.

4 VeriFinger 12.3/MegaMatcher 12.3

10

4

mailto:support@neurotechnology.com


Index

A
Application 3

F
Fingerprint Input 4

I
Introduction 1

L
Linux 6

M
Mac OS X 6

Main Window 3

O
Options Dialog 5

P
Proper Use of a Fingerprint Scanner 7

S
Support 10

System Requirements 1

W
Windows 3

5 VeriFinger 12.3/MegaMatcher 12.3

a


	VeriFinger 12.3/MegaMatcher 12.3 Algorithm Demo
	 Table of Contents
	1 Introduction
	1.1 System Requirements

	2 Application
	2.1 Windows
	2.1.1 Main Window
	2.1.2 Fingerprint Input
	2.1.3 Options Dialog

	2.2 Linux
	2.3 Mac OS X

	3 Proper Use of a Fingerprint Scanner
	4 Support
	Index


